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1
 Copyright Notices

Copyright©2017 – Expert4x, all rights reserved. This eBook is intended for the
purchaser’s personal use only. No part of this eBook may be reproduced or transmitted in
any form whatsoever, electronic, or mechanical, including photocopying, recording, or by
any informational storage or retrieval system without expressed written permission from
Expert4x.

Copyright©2017 EAfactory, all rights reserved. All title, including but not limited to
copyrights, in and to the MakeMoney EA and any copies thereof are owned by EAfactory
or its suppliers. All title and intellectual property rights in and to the content which may
be accessed through use of the MakeMoney is the property of the respective content
owner and may be protected by applicable copyright or other intellectual property laws
and treaties. All rights not expressly granted are reserved by EAfactory. For the full details
please refer to the End-User License Agreement ("EULA")
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Chapter

2
 Getting Started with the CandleTrader EA

Getting Started provides a guided exploration of the CandleTrader EA. It is geared for an
audience that has little or no knowledge of installing MT4 EA. It walks the novice user
through downloading and installing the CandleTrader EA.

2.1 Installing the CandleTrader EA
The CandleTrader EA comes with a setup application to provide a wizard based installation
process to the selected MT4 terminal.

Before you start...

• Ensure that you have the login credentials to the Web Support Centre.
• Ensure that you have an MT4 terminal version 4.00 build 1090 or later installed.

1. Exit MT4 if it was running.
2. Log in to the Web Support Centre.

3. Select the desired service and download the setup application with the latest version.
4. Run the setup application. Select the MT4 instance during setup to where you want

the service installed.
5. When setup completes start up MT4. CandleTrader EA entry should appear under the

EA node in the Navigator window (View > Navigator)

These pictures highlight the steps how to install the EA.

https://my.eafactory.com/expert4x
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The setup application lists the available MT4 instances. Select one of them for installation
target and click Next.

Note:

For some earlier version Windows version the list may not contain all the MT4 instances.
In this case use the Add target directory... button to navigate and pick up the desired
folder.
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For earlier Windows versions the typical MetaTrader installation location could be

C:\Program Files\BrokerSpecificName\

but you may have selected something else while performing the MetaTrader installation.
As a hint, the following shows you the default path to the main MT4 directory for some
brokers:

Broker Default Path

IBFX broker C:\Program Files\Interbank FX Trader

Tallinex broker C:\Program Files\Tallinex MetaTrader 4

ODL UK broker C:\Program Files\ODL MetaTrader 4

Always select the main MT4 folder itself for installation target, not any of its sub-
directories.

When the installation is complete, start up MT4 and check that the EA appears in the
Navigator window (View > Navigator):
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So everything is set up for the first activation of the CandleTrader Expert Advisor  .

2.2 CandleTrader Expert Advisor  First Time Activation
Step by step guide to get the EA up and running on a chart for the first time.

The following pictures demonstrate the first time activation of the CandleTrader Expert
Advisor  in a few steps.

Attach the EA to a chart

1. Drag & drop the CandleTrader Expert Advisor  from the Navigator window (View >
Navigator) to a chart window and select the Common tab:
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Note:  Ensure that the

• Allow live trading,
• Allow DLL import and
• Allow import of external experts

are checked.

2. Select the Inputs tab:
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This lists the parameters of the EA where the operational aspect of the CandleTrader
EA can be set up. For more details see the CandleTrader EA Configuration Guide – for
now click OK and let the EA start up with default settings.

Note:

At the very first time the EA may prompt for the Access ID to verify that the usage of
product is licensed.

The Access ID is pre-configured and is the same as the login name to the web
support site. Feel free to change your Access ID at the Web Support Centre and
ensure not to share it with anyone else. Enter the Access ID and click Save:

The CandleTrader EA is up and running

After successful authentication the CandleTrader EA starts up.

https://my.eafactory.com/expert4x


The CandleTrader Expert Advisor  has been attached to the chart. The smiley face in the
top-right corner shows that the initialisation of the CandleTrader Expert Advisor  was
successful and the EA is now looking for trading opportunities.

See the smiley face in the corner:

In case of a problem getting the EA up and running please refer to the Knowledgebase
section.
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3
 System Requirements

Overview of prerequisites in order to install and get the product up and running.

3.1 Operating System Requirements
In order to operate the CandleTrader EA a Microsoft Windows operating system is required
which supports MetaQuotes MetaTrader version 4.0 platform.

Note that the MetaQuotes MetaTrader software is also known and often referred to as
MT4.

3.2 Hardware Requirements
The minimum Random Access Memory (RAM) requirement is 384MB, however 512MB
RAM is recommended to avoid extended virtual memory usage. Note that this memory
requirement is for MetaTrader application only, excluding other applications running at
the same time (e.g. MS Office). If other applications are running parallel with MetaTrader
application please increase the RAM requirement accordingly.

3.3 MetaTrader (MT4) Requirements and Settings
The EA is compatible with MetaQuotes MetaTrader platform version 4.00 build 1090 or
higher. In general this is referred to as MT4 terminal, build 1090 or newer.

3.4 Forex Broker Requirements
The CandleTrader EA is compatible with both 4 and 5-digit data feeds based brokers. The
CandleTrader EA automatically detects the type of the feed and adjusts the EA parameter
pip values if and when necessary.

Both fixed and variable spread broker platforms are supported.

The selected MetaTrader based broker should allow keeping open orders on the account
for long period of time, i.e. the broker should not close and re-open orders over night for
swap calculation, or should not merge open orders for any reason.

IMPORTANT: For smooth trade management the MetaTrader application and the EA
should be on-line, up and running during all market open hours (usually Sunday to
Friday).

3.5 Hedging Support Requirements
The EA may open BUY as well as SELL positions at the same time on the same market.
Because of this the broker account must support the hedging of trades.



3.6 Non-FIFO Support Requirements
The CandleTrader EA may open and close positions out of order of the first-in-first-out
(FIFO) sequence. Therefore the broker account must support the order handling in non-
FIFO manner.

3.7 Account Type and Minimum Lot Size Requirements
A so-called Micro broker account is necessary if the available funds for the EA trading
is less than approx. $1000. The micro account allows the EA to open a position with
minimum lot size of 0.01. If you plan to use a broker account with the above funding
please ensure that your broker account offers this minimum lot size.

An easy way to double check the minimum lot size available on the broker account is to
attach the EA to a chart and check the Market Info section on the chart:

The Lot line shows Min:0.01 which tells that the minimum lot size requirement is 0.01 on
this broker account.

3.8 ECN/STP Broker Accounts
Many brokers offer Electronic Communications Network (ECN) or Straight Through
Processing (STP) accounts. Common behaviour for these accounts is the variable spread
and market orders where no initial stop loss and take profit targets can be specified. In
this case the market order must be submitted with no SL and TP values, and these values
are to be set in the second step using an additional order to the opened ticket.

The CandleTrader EA is compatible with the above ECN/STP broker accounts and needs no
additional settings to operate on them.
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4
 CandleTrader EA Configuration Guide

The CandleTrader EA configuration guide.

In order to activate the CandleTrader EA attach it to a chart window – for more details see
CandleTrader EA First Time Activation section.

4.1 Configuration and Operation Principles
The CandleTrader EA operational overview.

The CandleTrader EA manages only those tickets (a.k.a positions) on the account which
belong to the CandleTrader EA: every order submitted to the account is marked with the
MagicNumber and, in return, only those tickets on the account will be considered by the
CandleTrader EA which are marked with this MagicNumber.

In general it is recommended to run on an account one EA at a time. This helps
understanding the ongoing trades and troubleshoot situation if and when needed.

While this maybe feasible for demo accounts this may not be feasible for live accounts
where there could be the need to execute multiple expert advisors on the same account at
the same time.

Using multiple expert advisors on the same account is only viable if each and all expert
advisor will follow the above MagicNumber principle and they manage only their own
tickets on the account.

IMPORTANT: If you plan to use multiple expert advisors (other than the
CandleTrader EA) on the same account please ensure upfront with the expert
advisor providers that their EA's are suitable for that as per the above.

If you plan to use multiple CandleTrader EA's on the same account at the same time
please ensure that the MagicNumber is set to different and unique number for each chart
of the same market.

Here are few examples:

Market MagicNumber

EURUSD chart 1 8300

EURUSD chart 2 8301

EURUSD chart 3 8302

GBPUSD chart 1 8310

GBPUSD chart 2 8311

GBPUSD chart 3 8312

USDCAD single chart EA default or any other

USDCHF single chart EA default or any other
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4.2 CandleTrader EA Parameter Descriptions
The CandleTrader EA parameter descriptions.

4.2.1 CandleTrader EA Parameter Descriptions
The CandleTrader EA parameter descriptions.

 Trading Logic Settings
 Minimum Bar Height of Previous Bar

Minimum Bar Height of Previous Bar

A bar can only trigger new trades if its actual height is equal to, or greater than the value
of this Minimum Bar Height of Previous Bar parameter. The height of the previous bar is
calculated as the difference between the bar's high and low. When the bar's high and low
are equal, then the bar's height is zero.

The actual trade entries are placed as per the selected Entry Method, in line with the
Allowed Trade Direction settings.

Related reference
Entry Method on page 14
Allowed Trade Direction on page 15
Position Management on page 16
Day of Week & Time of Day Entry Filter on page 18
Operations Settings on page 21

 Entry Method

Entry Method

The way new trade entries are performed when the market price reaches the high or
the low of the previous bar. The new trade entry can be selected for bouncing (i.e. price
reversal) or breakout (i.e. price continuation) scenario.

Entry Method Description

Bounce: Sell @ High, Buy
@ Low

The EA performs price reversal trades according to
the following rules:

• When bid price reaches or goes beyond the
the HIGH of the previous bar: a SELL trade is
entered.

• When bid price reaches or goes beyond the
the LOW of the previous bar: a BUY trade is
entered.

Breakout: Buy @ High,
Sell @ Low

The EA performs price breakout trades according to
the following rules:

• When bid price reaches or goes beyond the
the HIGH of the previous bar: a BUY trade is
entered.

• When bid price reaches or goes beyond the
the LOW of the previous bar: a SELL trade is
entered.
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Maximum of one SELL and one BUY trade can be open at any time. This means that no
new SELL trade is entered if there is an open SELL trade, similarly no new BUY trade is
entered if there is an open BUY trade on the account for this EA instance. Furthermore, a
new SELL or a new BUY trade can only be entered once per bar. If a trade is entered and
gets closed off during the same bar, then no new trade gets entered until the next bar.

No new trade is entered if the height of the previous bar is below the minimum configured
size - see Minimum Bar Height of Previous Bar on page 14.

Keep in mind that new trades may only get entered by the EA if that direction is enabled -
see Allowed Trade Direction on page 15.

Related reference
Minimum Bar Height of Previous Bar on page 14
Allowed Trade Direction on page 15
Position Management on page 16
Day of Week & Time of Day Entry Filter on page 18
Operations Settings on page 21

 Allowed Trade Direction

Allowed Trade Direction

Controls the type of trades, buy or sell entries, the EA may execute.

Allowed Trade
Direction

Description

Long (Buy) Only Allowed The EA may enter the following trade types:

• Long (Buy) trades: Enabled.
• Short (Sell) trades: Disabled.

Short (Sell) Only Allowed The EA may enter the following trade types:

• Long (Buy) trades: Disabled.
• Short (Sell) trades: Enabled.

Long & Short Allowed The EA may enter the following trade types:

• Long (Buy) trades: Enabled.
• Short (Sell) trades: Enabled.

The actual trade entries are placed as per the selected Entry Method, in line with the
Minimum Bar Height of Previous Bar settings.

Related reference
Minimum Bar Height of Previous Bar on page 14
Entry Method on page 14
Position Management on page 16
Day of Week & Time of Day Entry Filter on page 18
Operations Settings on page 21
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 Position Management

 Trade Limits

 Max Spread for Position Entry

Max Spread for Position Entry

The maximum value of the current market spread the EA is allowed to perform market
entry, i.e. to open a new position. If the current spread of the market exceeds this limit
then the EA will not consider to open position until after the spread drops to or below this
value.

 Position Sizing

 Position Sizing Method

Position Sizing Method

The position sizing mechanism used for new trades at market entry.

Position Sizing Method Description

Percent of Account Free
Margin

The lots for new position is calculated based on

• Free Margin available on account, and
• Initial Risk Percent, and
• Initial SL for New Position

The lots for the new position is calculated in a way
that should the initial SL get hit the loss would not
be higher than the risk percent of the free margin.
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Position Sizing Method Description

Percent of Account Equity The lots for new position is calculated based on

• Equity available on account, and
• Initial Risk Percent, and
• Initial SL for New Position

The lots for the new position is calculated in a way
that should the initial SL get hit the loss would not
be higher than the risk percent of the equity.

Percent of Account
Balance

The lots for new position is calculated based on

• Balance available on account, and
• Initial Risk Percent, and
• Initial SL for New Position

The lots for the new position is calculated in a way
that should the initial SL get hit the loss would
not be higher than the risk percent of the account
balance.

Manual Lot Size The lots for the new position is not calculated by the
EA, instead it is fixed and set to the user-defined
value from Lots for Manual Lot Size.

The position sizing calculation takes place at the time of market entry, when all the entry
criteria are met.

The calculated lots value is normalized according to the minimum lots size and lots
stepping requirements of the MT4 terminal. Therefore the actual risk amount may vary
and will be a best effort and approximate of the configured target risk value.

Furthermore, the market conditions (e.g. fast price movements) or the MT4 operational
conditions (e.g. lost connectivity to broker) may alter the actual exit point of an open
trade, resulting in higher or lower actual risk compared to the configured target risk value.

Related reference
Initial Risk Percent on page 17
Lots for 'Manual Lot Size' on page 17

 Initial Risk Percent

Initial Risk Percent

Determines the risk amount allocated to a new trade as a percent of the broker account
value. For more details see the Position Sizing Method

Related reference
Position Sizing Method on page 16

 Lots for 'Manual Lot Size'

Lots for Manual Lot Size

Sets the fixed lot size for new positions to this user-defined value when the Manual Lot
Size option is selected for Position Sizing Method.

Related reference
Position Sizing Method on page 16
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 Initial Stop & Target

 Initial SL for New Position

Initial SL for New Position, Pips

The Stop Loss value in pips for a new position, set after market entry. This must be set to
higher than zero.

Related reference
Position Sizing Method on page 16

 Take Profit

Take Profit, Pips

Target profit value in pips for a new position, set after market entry. The Take Profit must
be set to higher than zero.

 Day of Week & Time of Day Entry Filter
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 Reference Time Selection

Reference Time Selection

Selects the nature of the time used by the EA when time specific actions are performed.

Reference
Time Selection

Description

Broker Server
Time

Entry window hour and minute settings are relevant to the
broker's server time. See below picture showing the broker
server time in the Market Watch window.

PC Local Time Entry window hour and minute settings are relevant to the
local time of the PC hosting the MT4 terminal and EA.
When setting up the time parameters consider the time zone
differences between the market open hours versus the PC
local time.

GMT Time

(Set GMT Offset
Below)

Entry window hour and minute settings are relevant to the
selected GMT offset.

This feature is useful to keep the entry window hour and
minute settings the same when the EA is executed across
different brokers. In this case only the broker GMT offset
needs to be set on the different brokers' MT4 instances,
and the EA adjusts automatically the entry window for the
broker.

In this case, use the Set GMT Offset to select the broker
offset and always set the window hour values in GMT +0
time zone.

 GMT Offset of Broker
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GMT Offset of Broker

The time zone shift of the MT4 broker's server time. This parameter is only required if
GMT Time option is selected for the Reference Time Selection.

Unfortunately MT4 terminal does not provide this broker GMT offset information therefore
a query to the broker maybe needed to get this value. As an alternative, one may make
an attempt to calculate this offset through the following steps:

 1.The Market Watch window's header shows the broker's server time, press Ctrl+M in
the MT4 terminal:

This time can be compared to the GMT+0 time to calculate the GMT offset of the
broker.

 2.In a web browser search for gmt time keywords to see the current GMT time.
 3.Then compare the search result of current GMT time to the current time displayed by

the Market Watch window of the MT4 terminal. The difference of the two times gives
the broker GMT offset.

Based on past experience, with no guarantee that the information is correct, these are a
few sample broker GMT offsets observed as of July 2015:

MT4
Terminal

Broker GMT Offset

AxiTrader AxiCorp Financial Services Pty Ltd +3

IC Markets International Capital Markets Pty Ltd +3

InstaForex InstaForex Companies Group +3

FXCM Forex Capital Markets Inc +3

ThinkForex TF Global Markets (Aust) Pty Ltd +3

RoboForex EU RoboForex (CY) Ltd +3

Tallinex Tallinex Ltd 0
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MT4
Terminal

Broker GMT Offset

Oanda OANDA Corporation -4

MB Trading FX MB Trading Futures Inc -4

The value in the GMT Offset column could be used for the EA parameter GMT Offset of
Broker.

 Entry Window From Hour/Minute - Entry Window Until Hour/Minute

Entry Window From Hour/Minute - Entry Window Until Hour/Minute

Limits the period of a day when a new position entry may take place.

The From Hour & Minute is inclusive, while the Until Hour & Minute is exclusive. The
following table shows examples how to configure these parameters for the entry window
period:

Desired Entry Period Entry Window From Entry Window Until

8 – 10

(i.e. 8:00.00–9:59.59)

Hour = 8

Minute = 0

Hour = 10

Minute = 0

10-17

(i.e. 10:00.00-16:59.59)

Hour = 10

Minute = 0

Hour = 17

Minute = 0

All Day Hour = 0

Minute = 0

Hour = 24

Minute = 0

The entry window from and until hours are specific to the selected time at Reference Time
Selection.

 Monday ... Sunday Trade Entry

Monday ... Sunday Trade Entry

Days allowed for new position entry. Subsequent management of stop loss or exit of
already open trades may happen outside of the enabled days, only the entry of new
positions is limited to the selected days:

Day of Week
Trade Entry

Description

No Entry No new entry is executed on that day.

Stop Loss management, if turned on, for existing open
positions are still executed as normal.

Entry Enabled New entry is allowed for the day when all other entry criteria
are met.

 Operations Settings



 Magic Number Parameter

Magic Number

The EA marks its orders with this value when submitting to the broker account, and picks
up orders which are marked with this magic number value and belong to the chart of the
EA. In the case of multiple EA's running on the same market ensure that they get unique
Magic Number allocations to avoid cross-impact between the EA instances handling the
orders. See Configuration and Operation Principles section for more explanation and setup
examples.

Related information
Configuration and Operation Principles on page 13
The CandleTrader EA operational overview.



23

Chapter

5
 Knowledgebase

Frequently Asked Questions and other common use cases.

5.1 Sad Face Instead of Smiley Face After Attach

Issue

After attaching to chart the EA is not managing trades, a sad face appears in the top right
corner of the chart.

EA's common parameters might be not enabled

The Allow live trading, Allow DLL imports and Allow import of external experts
might be not enabled

• Verify that the Allow live trading, Allow DLL imports and Allow import of
external experts are checked in the EA property dialog (F7).

Autotrading is disabled

The AutoTrading might be disabled

• Verify that the toolbar button AutoTrading is pressed.

Toolbar button when Expert Advisors disabled:
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Click to enable:

5.2 EA Is Not Starting Up After Attach to Chart

Issue

The EA reports successful initialisation and advises about disabled Expert Advisors.

Autotrading is disabled

The AutoTrading might be disabled

• Verify that the toolbar button AutoTrading is pressed.

Toolbar button when Expert Advisors disabled:

Click to enable:

5.3 No Updates to Chart

Issue

The CandleTrader EA does not update information on the chart for several minutes.

Connection Lost

MetaTrader should be connected to the broker's server.
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1. Check the bottom right corner of MetaTrader, this is when it has lost connection to
the server:

2. If connection is lost then login again or restart MT to force reconnection. Try again
activating the CandleTrader EA when connection is back.

Demo account is expired

MT4 will not be able to connect to the demo account if it's expired. In this case MT4 will
keep asking for the login details and fail all login attempt.

• When this happens open a new demo account (right click Accounts in Navigator
window and select Open an Account).

Market is closed

New tick information and updates to chart happens when markets are open.

• Double check that markets are meant to be open currently.

Disk is full

There should be at least 50MB free disk space available on the drive MetaTrader is
installed on.

• If the free disk space is low then free up space.

5.4 Prompted for Access ID at Service Access Settings

Issue

After attaching to chart the CandleTrader EA asks for my Access ID in the Service Access
Settings window.

Type in your Access ID

The CandleTrader EA checks that the usage of product is appropriately licensed. After
product purchase a user profile is created on our web support site and the product can be
downloaded from that web site. The support site allows to set up an Access ID which is
required by the CandleTrader EA to validate the product licence. By default this Access ID
is configured to be the same as your selected login name to the web support site.

• When prompted, please enter your Access ID to the window and click Save:
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Please do not share out to others your Access ID. That is against the licence
agreement terms and conditions and also all 3rd party usages will count when
checking the number of EA copies being used. Sharing out your Access ID can result
in licence check failure and the EA may stop functioning.

Keep your Access ID secure, change it away from the its default value at any time on
the Web Support Centre site.

5.5 Backtest In Visual Mode Not Working

Issue

In the Strategy Tester using the visual mode DLL imports not allowed message
appears on the chart. No result after the Strategy Tester finished its run.

Global Allow DLL imports is not enabled

You may need to enable the DLL imports in the MT4 for terminal global parameters to run
the CandleTrader EA in the backtest environment.

1. Open the MT4 global Options by selecting Tools > Option (CTRL+O)
2. Select the Expert Advisors tab
3. Check the Allow DLL import

https://my.eafactory.com/expert4x
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5.6 Backtest Not Working

Issue

After the backtest finished no result showing.

Global Allow DLL imports is not enabled

You may need to enable the DLL imports in the MT4 for terminal global parameters to run
the CandleTrader EA in the backtest environment.



28

1. Open the MT4 global Options by selecting Tools > Option (CTRL+O)
2. Select the Expert Advisors tab
3. Check the Allow DLL import

5.7 Step-by-step Installation of an Expert4x EA or Indicator
In this tutorial the Tallinex MetaTrader (MT4) is used as an example. Replace the Tallinex
MetaTrader with your broker specific MetaTrader.

1. Start your MT4 terminal and select the File > Open Data Folder menu

The menu opens a File Explorer.
2. Close your MT4
3. Check the File Explorer

• If the File Explorer shows a folder like this one below
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and you see the origin.txt or the origin file go to the standard installation
page.

• If the File Explorer shows a folder like this one below

and you see the terminal.exe or terminal file go to the non-standard
installation page.

5.7.1 Standard EA, Indicator installation
In the opened File Explorer the origin.txt or the origin file was found.

Please follow through the steps below to install the Expert4x EA or Indicator on your MT4

1. Double click the origin.txt file and take a note of the MetaTrader location.
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2. Start the EA or indicator setup program. Follow through the setup until you reach the
Select Target MetaTrader Directory window.

3. In this window select your targeted MetaTrader's Data Folder, as per the origin.txt
noted earlier, and click Next

4. Follow through the rest of the setup application.
5. In the end click Install
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6. Check the EA or Indicator in the MetaTrader after installation
a) Start your MetaTrader
b) In the Navigator panel open the Expert Advisors section if you installed an

EA or the Indicators section if you installed an Indicator and look for the EA or
Indicator.

5.7.2 Non-standard EA, Indicator installation
In the opened File Explorer the terminal.exe or terminal file was found.

Please follow through the steps below to install the an Expert4x EA or Indicator on your
MT4

1. Start the EA or indicator setup program. Follow through the application until you
reach the Select Target MetaTrader Directory window.

2. Click Add target directory... button

3. Navigate to your MetaTrader folder

and click OK.
4. Scroll down to the end of the list. Select the target directory. Click Next.



5. Follow through the rest of the setup application.
6. In the end click Install

7. Check the EA or Indicator in the MetaTrader after installation
a) Start your MetaTrader
b) In the Navigator panel open the Expert Advisors section if you installed an

EA or the Indicators section if you installed an Indicator and look for the EA or
Indicator.
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6
 Operational Messages

The CandleTrader EA operational messages and resolution guide.

Code Severity Message Description

1001 Error Setup problem:
DLL imports not
allowed. Tick Allow
DLL imports in
Common tab of the
properties window.

Configuration
setting is missing
to allow the EA
to use dynamicaly
loaded libraries
(DLLs). Enable the
load of DLLs and
restart the EA.
More...

1002 Error Incomplete EA
installation: Run
setup application
for MT4 instance
"<MT4DataPath>'s
Data Folder"

Product installation
is not complete or
damaged. Run the
setup application
for the MT4
terminal instance
as displayed.
More...

1006 Error MT4 Expert
Advisors are
disabled: click
AutoTrading icon
on MT4 toolbar to
execute the EA.

EA does not
perform its
operations, not
monitoring nor
reacting to price
movements of the
market. More...

1007 Error Live trading is not
allowed (no smiley
face): press F7
and tick Allow live
trading box on
Common tab.

The EA is unable
to perform trading
operations, there is
a sad icon in the
top right corner of
the chart. More...

1008 Error Authentication
failed or
interrupted
(<Stopped>,
<Status>,
<Response>,
<Reason>,
<FlipOverCount>,
<Latency>)

The EA is not able
to authenticate the
user access to the
service at its start
up time. More...
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Code Severity Message Description

1017 Error Initial risk
<InitialRiskPercent>
% is too
low. Set EA
parameter 'Initial
Risk Percent' to
higher than zero.

Position sizing
feature is enabled
but no Initial Risk
Percent or Initial
SL is configured.
More...

1018 Error Initial SL
<InitialStopLoss>
is too low. Set EA
parameter 'Initial
SL for New
Position' to higher
than zero.

Position sizing
feature is enabled
but no Initial Risk
Percent or Initial
SL is configured.
More...

2118 Error Service access
disabled
(<AccessID>,
<ConfirmationID>)
- shutting down...

The user quits
the authentication
process, or the
EA is not able
to authenticate the
user access to the
service. More...

6.1 Message 1001

Code Severity Message Description

1001 Error Setup problem:
DLL imports not
allowed. Tick Allow
DLL imports in
Common tab of the
properties window.

Configuration
setting is missing
to allow the EA
to use dynamicaly
loaded libraries
(DLLs). Enable the
load of DLLs and
restart the EA.
More...

Setup problem: DLL imports not allowed

Issue

The EA is not able to start up when gets attached to a chart because some of its
dependencies could not be loaded into memory. The EA requires some dynamically loaded
libraries (DLL) to be loaded into memory from disks. When the EA configuration settings
do not allow the load of DLLs then the EA cannot start up and reports this error message.

Possible root cause

• The EA configuration does not allow for the load of DLLs.

Resolution

Enable the load of DLLs in the EA configuration dialog.

 1.Attach the EA to a chart, or if already attached then select the chart and

• In case of an EA: press F7
• In case of an indicator: press Ctrl+I and double-click the name of the indicator

in the list.
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 2.Go to the Common tab of the Property window.
 3.Tick the checkbox Allow DLL imports.
 4.Click OK.

6.2 Message 1002

Code Severity Message Description

1002 Error Incomplete EA
installation: Run
setup application
for MT4 instance
"<MT4DataPath>'s
Data Folder"

Product installation
is not complete or
damaged. Run the
setup application
for the MT4
terminal instance
as displayed.
More...

Incomplete Installation

Issue

The EA is not able to start up when gets attached to a chart because some of its
dependencies could not be found on the file system.

Possible root cause

• The EA setup application was not able to perform all its steps, not completed in full.
• The product was installed manually and some of the steps were missed.
• The MT4 instance's file system got damaged, some files got corrupted or deleted.

Resolution

Download the EA setup application and execute it to get the product installed for the MT4
instance:

 1.Download the setup application from Web Support Centre.
 2.Execute the setup application to get the product installed. For installation guide refer

to any of the following:

• Getting Started with the CandleTrader EA on page 4
• Step-by-step Installation of an Expert4x EA or Indicator on page 28

https://my.eafactory.com/expert4x
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6.3 Message 1006

Code Severity Message Description

1006 Error MT4 Expert
Advisors are
disabled: click
AutoTrading icon
on MT4 toolbar to
execute the EA.

EA does not
perform its
operations, not
monitoring nor
reacting to price
movements of the
market. More...

EA AutoTrading Disabled

Issue

The EA is not responding to price movements, not performing its logic upon data ticks
coming in from the broker. The MT4 toolbar button AutoTrading is disabled.

Possible root cause

• The AutoTrading button on the MT4 toolbar is disabled.

Resolution

Press the AutoTrading button on the MT4 toolbar.

6.4 Message 1007

Code Severity Message Description

1007 Error Live trading is not
allowed (no smiley
face): press F7
and tick Allow live
trading box on
Common tab.

The EA is unable
to perform trading
operations, there is
a sad icon in the
top right corner of
the chart. More...

Live Trading Not Allowed

Issue

The EA is unable to perform trading operations, there is a sad icon in the top right corner
of the chart.

Possible root cause

• The Allow live trading checkbox is not ticked at the EA properties window.
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Resolution

Enable live trading in the EA properties window.

 1.Go to the chart and press F7.
 2.Go to the Common tab of the Expert properties window.
 3.Tick the checkbox Allow live trading.
 4.Click OK

6.5 Message 1008

Code Severity Message ToDo

1008 Error Authentication
failed or
interrupted
(<Stopped>,
<Status>,
<Response>,
<Reason>,
<FlipOverCount>,
<Latency>)

The EA is not able
to authenticate the
user access to the
service at its start
up time. More...

Failed Authentication

Issue

The EA is not able to authenticate the user access to the service at attach or restart time
and does not start up.

Possible root cause

• The EA could not connect to the authentication server.
• The user quit the authentication process.
• There is a typo in the Access ID entered by the user.
• The CandleTrader EA is not yet purchased by the user.
• The CandleTrader EA was purchased, but not yet activated by the user.
• The CandleTrader EA was purchased or a trial started, but the licensed period (e.g.

calendar days) has lapsed.
• The CandleTrader EA was purchased, but the licensed usage limit (e.g. number of

parallel accesses) is breached by the user.

Resolution
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Double check the following items to find resolution to the issue.

 1.Ensure that the computer has working Internet connection. For example, go to the
Web Support Centre and see if the page loads with no issues. When the Internet
connection is working, restart the EA by pressing F7 and clicking the OK button of
the Expert property window.

 2.Ensure you enter the correct Access ID, case sensitive, without any typo, and click
the Save button of the Service Access Settings authentication window.

 3.Ensure you have purchased the product. Log in to the Web Support Centre and
select the CandleTrader EA from the product list. If the product is not available for
download then it is yet to be purchased at the Web Support Centre.

 4.Count the number of computers you are running the CandleTrader EA on. If it is more
than what the purchased EA licence copies allow then either shut down on the excess
number of the computers all the running CandleTrader instances, or purchase more
licence at the Web Support Centre.

6.6 Message 1017

Code Severity Message Description

1017 Error Initial risk
<InitialRiskPercent>
% is too
low. Set EA
parameter 'Initial
Risk Percent' to
higher than zero.

Position sizing
feature is enabled
but no Initial Risk
Percent or Initial
SL is configured.
More...

Missing Initial Risk Percent for Position Sizing Feature

Issue

The position sizing feature is enabled and it requires both the Initial Risk Percent as
well as the Initial SL to be set higher than zero. Refer to Dynamic Trailing Stop for more
details.

Possible root cause

• The Initial Risk Percent is turned off, set to value zero.

Resolution

Set the Initial Risk Percent to higher than zero value.

https://my.eafactory.com/expert4x
https://my.eafactory.com/expert4x
https://my.eafactory.com/expert4x
https://my.eafactory.com/expert4x
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Related reference
Dynamic Trailing Stop

6.7 Message 1018

Code Severity Message Description

1018 Error Initial SL
<InitialStopLoss>
is too low. Set EA
parameter 'Initial
SL for New
Position' to higher
than zero.

Position sizing
feature is enabled
but no Initial Risk
Percent or Initial
SL is configured.
More...

Missing Initial SL for Position Sizing Feature

Issue

The position sizing feature is enabled and it requires both the Initial Risk Percent as
well as the Initial SL to be set higher than zero. Refer to Dynamic Trailing Stop for more
details.

Possible root cause

• The Initial SL is turned off, set to value zero.

Resolution

Set the Initial SL to higher than zero value.

Related reference
Dynamic Trailing Stop

6.8 Message 2118

Code Severity Message ToDo

2118 Error Service access
disabled
(<AccessID>,
<ConfirmationID>)
- shutting down...

The user quits
the authentication
process, or the
EA is not able
to authenticate the
user access to the
service. More...

Aborted Authentication

Issue

The EA is not able to authenticate the user access to the service at attach or restart time
and does not start up.

Possible root cause

• The user quit the authentication process.
• The EA could not connect to the authentication server.
• There is a typo in the Access ID entered by the user.
• The CandleTrader EA is not yet purchased by the user.
• The CandleTrader EA was purchased, but not yet activated by the user.



• The CandleTrader EA was purchased or a trial started, but the licensed period (e.g.
calendar days) has ellapsed.

• The CandleTrader EA was purchased, but the licensed usage limit (e.g. number of
parallel accesses) is breached by the user.

Resolution

Double check the following items to find resolution to the issue.

 1.Ensure that the computer has working Internet connection. For example, go to the
Web Support Centre and see if the page loads with no issues. When the Internet
connection is working, restart the EA by pressing F7 and clicking the OK button of
the Expert property window.

 2.Ensure you enter the correct Access ID, case sensitive, without any typo, and click
the Save button of the Service Access Settings authentication window.

 3.Ensure you have purchased the product. Log in to the Web Support Centre and
select the CandleTrader EA from the product list. If the product is not available for
download then it is yet to be purchased at the Web Support Centre.

 4.Count the number of computers you are running the CandleTrader EA on. If it is more
than what the purchased EA licence copies allow then either shut down on the excess
number of the computers all the running CandleTrader instances, or purchase more
licence at the Web Support Centre.

https://my.eafactory.com/expert4x
https://my.eafactory.com/expert4x
https://my.eafactory.com/expert4x
https://my.eafactory.com/expert4x
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Chapter

7
 Support

Please contact support@eafactory.com if you require any further assistance. Please copy
info@expert4x.com on your email.

mailto:support@eafactory.com?cc=info@expert4x.com&subject=Support%20Request&body=EA%20name:%20%0D%0A%0D%0APlease%20describe%20here%20your%20request
mailto:info@expert4x.com?cc=support@eafactory.com&subject=Support%20Request&body=EA%20name:%20%0D%0A%0D%0APlease%20describe%20here%20your%20request
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